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LEKCIJA 1

 

Osnove Photoshopa

 

Ãta je opisano u ovoj lekciji:

 

é

 

Snalaæenje u Photoshopu

 

é

 

Kutija sa alatkama

 

é

 

Traka sa opcijama alatki

 

é

 

Sadræaj menija

 

é

 

Podeãavanje parametara programa

 

Photoshop je 

 

i daàe

 

 vrhunski grafiåki program, iako se dosta razlikuje od svoje prve 
verzije objavàene pre skoro 20 godina. Mada se uglavnom upotrebàava za retuãi-
raçe fotografija i obradu slika, moæete ga koristiti i za izradu novih slika – od 
poåetka ili doradom postojeñe fotografije. U Photoshopu åak moæete i da slaæete 
tekst, da obiåna slova pretvorite u sjajna, metalna ili trodimenzionalna, pufnasta, 
i da uradite joã ãtoãta. Rad u Photoshopu mnogo je zabavniji od igranja video igrice, 
a nije tako teæak kao ãto moæda mislite.

 

Snalaæeçe u Photoshopu 

 

Kada prvi put otvorite Photoshop, videñete çegovu kutiju sa alatkama na levoj strani 
ekrana, traku sa opcijama alatki (Options Bar) odmah ispod menija pri vrhu ekrana, 
nekoliko skupova plutajuñih paleta s desne strane i – u sredini –  ekran dobrodoãlice 
s vezama ka pomoñnim informacijama o nekim uvodnim temama. (Ako radite na 
Macu, videñete i deo radne povrãine i/ili prozore aktiviranih programa.) Neñete videti 
radno podruåje jer Photoshop, za razliku od mnogih programa, ne pravi nov doku-
ment automatski. To ima smisla, zato ãto ñete u Photoshopu najåeãñe obraœivati slike 
iz drugih izvora. To mogu da budu slike s digitalnog fotoaparata ili skenera, slike koje 
ste preuzeli sa Interneta, ili fotografije sa CD-a. U lekciji 2, “Otvaraçe i snimaçe 
datoteka”, nauåiñete sve o otvaraçu ovih slika. Zasad ñemo napraviti prazan doku-
ment kako biste mogli da isprobate neke Photoshopove alatke.
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Zapoåiçaçe nove slike

 

File

 

>

 

New je prva stavka u prvom Photoshopovom meniju. Kada je izaberete, otvoriñe 
se okvir za dijalog New (slika 1.1). U poàe Name upiãite ime nove datoteke – na pri-
mer, Nova slika – ili ga zasad ostavite prazno. U narednim odeàcima ukratko je opi-
sano kako da poånete rad na novoj datoteci.

 

Veliåina slike

 

Veliåinu slike najlakãe ñete izabrati iz padajuñih lista Preset i Size. U listi Preset nave-
deno je nekoliko kategorija: Clipboard, Default Photoshop Size, U.S. Paper, Internatio-
nal Paper, Photo, Web, Mobile & Devices, Film & Video i Custom. Nakon ãto izaberete 
opciju Preset, postaje dostupan i meni Size tako da moæete odabrati veliåinu papira iz 
date kategorije. Na primer, kada iz menija Preset izaberete opciju U.S. Paper, u meniju 
Size dostupne su opcije Letter, Legal i Tabloid. Photoshop CS3 nudi i ãirok spektar TV 
i video formata, ukljuåujuñi PAL i HDTV, kao i veliåine koje se uobiåajeno koriste za 
telefone, ruåne digitalne organizatore i druge ureœaje. Naravno, moæete i sami da 
zadate veliåinu slike – ãirinu i visinu – u pikselima, centimetrima, inåima, taåkama, 
pajkovima ili prema broju kolona koje slika zauzima. Navedenim mernim jedini-
cama pristupate preko odgovarajuñih padajuñih lista, koje otvarate kada pritisnete 
dugme sa strelicom nagore, odnosno nadole, pored merne jedinice (slika 1.2).

 
SLIKA 1.1
Za pravljenje praznog 

dokumenta koristite 

okvir za dijalog New.

 
SLIKA 1.2
Photoshop nudi stan-

dardne veliåine slika za 

ãtampanje i prikazivanje 

na ekranu, kao i opciju 

Custom koja omoguñava 

da sami unesete odgo-

varajuñe mere.
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Zasad izaberite opciju Default Photoshop Size. Dobijate radnu povrãinu veliåine 
7 

 

×

 

 5 inåa, pogodnu za veñinu poslova.

 

Rezolucija

 

Termin 

 

rezolucija

 

 odnosi se na broj piksela slike po inåu. Rezolucija slike je vaæna 
zato ãto odreœuje kvalitet. Veñe rezolucije daju kvalitetniju sliku, ali je potrebno viãe 
memorije. Rezolucija veñine slika koje viœate u ãtampi iznosi od 150 do 300 ppi 
(piksela po inåu).

S druge strane, rezolucija raåunarskog monitora je mnogo maça – 72 ppi. Prema 
tome, rezoluciju uvek podeãavajte u zavisnosti od izlaznog medija. Zasad zadræite 
rezoluciju 72 ppi zato ãto ñemo sliku gledati samo na ekranu. Iz istog razloga, pode-
site opciju Color Mode na RGB Color, kao ãto je prikazano na slici 1.1. RGB je model 
boja za prikazivaçe na monitorima. (Sve o koriãñeçu boja i modelima boja nauåi-
ñete u lekciji 5.)

U padajuñoj listi Background Contents izaberite stavku White da biste dobili belo 
“platno” za slikaçe.

Kada pritisnete OK u okviru za dijalog New, otvoriñe se nov prozor. To je 

 

aktivan 
prozor

 

, a 

 

platno

 

 je veliki beli pravougaonik u çemu. U Photoshopu moæe istovre-
meno biti otvoreno viãe prozora, ali samo jedan moæe da bude aktivan. Aktivan pro-
zor je uvek u predçem planu. U çemu pravite i obraœujete slike.

Postavite pokazivaå miãa u doçi desni ugao prozora pa pritisnite i povucite. Pro-
zor se poveñava, ali veliåina platna ostaje ista. Poãto otvorite novu datoteku, veliåinu 
platna moæete promeniti samo ako izaberete Image

 

>

 

Canvas Size. Ova komanda 
omoguñava da zadate novu visinu i ãirinu platna (slika 1.3). Pritiskaçem jednog od 
devet kvadrata u oblasti Anchor, zadajete oblast u odnosu na koju se platno ãiri ili 
skupàa. (Naravno, ako promenite veliåinu slike, meça se i veliåina platna. Meœu-
tim, meçajuñi veliåinu platna moæete da podesite prostor oko postojeñe slike.)

 

Magija!
Ako na Clipboardu imate kopiju neke slike u trenutku kada otvarate nov

dokument, u okviru za dijalog New automatski ñe se prikazati njena veliåina.

Ukoliko izaberete neku drugu veliåinu a zatim se predomislite, iz menija Pre-

set odaberite opciju Clipboard da biste se vratili na veliåinu kopirane slike.

 Da li ste
 znali?

 

Mislite unapred...
Ako nameravate da slike objavite na Webu, potpuno zanemarite rezoluciju.

Razmiãàajte o dimenzijama slike u pikselima, a ne kao o neåemu ãto ima

“toliko i toliko centimetara na 72 ppi”. Mislite o tome koliko ñe prostora na

Web strani slika zauzeti. S druge strane, ako dokument ãtampate na visoko-

kvalitetnom mlaznom ili laserskom ãtampaåu u boji, podesite rezoluciju na

200 ppi. Rezolucija od 300 ppi trebañe vam samo ukoliko pripremate rad za

visokokvalitetnu ãtampu u boji.

 Da li ste
 znali?
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Opcija Relative je veoma korisna. Ako je potvrdite, platno se poveñava tako ãto se 
oko slike dodaje prostor. Platno moæete i da smanjite za odreœenu vrednost: samo 
unesite tu vrednost sa znakom minus i uverite se da je potvrœena opcija Relative. 
Dodavanje obiånog okvira oko slike takoœe je lako – samo potvrdite opciju Relative 
i unesite vrednost jednaku dvostrukoj ãirini okvira.

 

Kutija sa alatkama

 

Kutija sa alatkama sliåna je umetniåkom ateàeu – sadræi sav pribor koji ñete koristiti 
za crtaçe, bojeçe, brisaçe i svaku drugu obradu slika. Ako ste koristili neku od 
prethodnih verzija Photoshopa, åeka vas nekoliko iznenaœeça. Pojedine alatke su 
promenile mesto i dobile nove moguñnosti, a ima i nekoliko izuzetnih novina. Pho-
toshopove alatke svrstavamo u åetiri kategorije:

 

é

 

alatke za izbor

 

é

 

alatke za slikaçe

 

é

 

olovke i alatke za tekst

 

é

 

alatke za prikaz

Pogledajmo na brzinu sve ove alatke. (Kasnije ñemo navesti viãe detaàa o çima.) 
Na slici 1.4 prikazana je kutija sa obeleæenim alatkama.

 
SLIKA 1.3
Pritisnite beli kvadrat u 

oblasti Anchor da biste 

sadræaj tekuñeg platna 

smestili na odgovarajuñi 

deo novog platna.

 

Uzgred budi
 reåeno

Ãta je to u donjem desnom uglu?
U doçem desnom uglu dugmadi nekih alatki nalazi se mali crni trougao. On

oznaåava da postoji potpaleta sa joã srodnih alatki. Pritisnite bilo koje

dugme oznaåeno trougliñem i dræite pritisnut taster miãa da biste videli

ostale dostupne alatke iz date grupe.
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Alatke za izbor

 

Na vrhu kutije je grupa alatki za izbor cele slike ili dela slike. Postoje tri podvrste 
alatki za izbor: okviri za izbor (Marquees), lasa (Lassos) i alatka za brzo biranje 
(Quick Selection). Izabrano podruåje je na ekranu oznaåeno trepñuñim okvirom za 
izbor koji se na engleskom zove 

 

marquee

 

, po bioskopskim svetleñim reklamama koje 
se pale i gase. Povlaåeçem alatki Marquee i Lasso obuhvatate deo slike koji hoñete 
da izaberete. Slika 1.5 prikazuje potpalete alatki za izbor Marquee i Lasso. 

 

Spot Healing Brush/Healing Brush/Patch/Red Eye
(alatke za retuãiraçe slike)

Adobe.com

Olovke i
alatke za tekst

Alatke za izbor

Alatke za slikanje

Foreground Color
(boja prednjeg plana)

Swap Colors
(zamena boja)

Quick Mask Mode
(reæim za brzo

maskiranje)

Alatke za prikaz

Marquee (okviri za izbor)

Lasso (alatke laso)

Crop (alatka za opsecaçe)

Move (alatka za pomeranje)

Quick Selection (alatka za brzo biraçe)

Slice (alatke za seåenje)

Eraser/Background Eraser/Magic Eraser
(gumica/gumica za brisaçe pozadine/åarobna gumica)

Blur/Sharpen/Smudge (zamagljivanje/izoãtravanje/razmazivanje)

Brush/Pencil/Color Replacement (åetkica/olovka/zamena boja)

History Brush/Art History Brush
(istorijska åetkica/åetkica istorije umetnosti)

Gradient/Paint Bucket (prelivi/kanta s bojom)

Dodge/Burn/Saturate (posvetljavanje/zatamnjivanje/zasiñenost)

Clone Stamp/Pattern Stamp (peåati)

Path Selection/Direct Selection (alatke za izbor putaça)

Pen (pera)

Type (alatke za tekst)

Shape/Line (alatke za vektorske oblike i linije)

Notes (alatka za napomene)

Hand (ãaka)

Eyedropper/Color Sampler/Ruler (pipeta/biraå boja/leçir)

Zoom (zumiranje)

Default Colors (podrazumevane boje)

Background Color (boja pozadine)

Screen Modes (reæimi prikaza)

SLIKA 1.4
U Photoshopovoj kutiji sa 

alatkama, alatke su gru-

pisane po vrsti.
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Alatka Quick Selection bira oblasti slike prema boji. Sliåna je staroj alatki åarobni 
ãtapiñ (Magic Wand), koja je sada sakrivena u podmeniju alatke Quick Selection – 
ali je åesto mnogo bolja! Koristite je tako ãto pritiskate i povlaåite da biste “slikali” 
preko povrãine koju hoñete da izaberete. Posledça u ovom skupu je alatka Move. 
Poãto napravite selekciju, upotrebite alatku Move da biste premestili izabrano pod-
ruåje na drugo mesto na slici.

Viãe o najefikasnijim naåinima pravljenja selekcija za razliåite svrhe, nauåiñete 
u lekciji 3.

Preostale dve alatke u oblasti Selection jesu Crop i Slice. Alatku Crop koristite da 
biste platno opsekli na veliåinu slike, briãuñi tako sve ãto je izvan te oblasti. Alatka 
Slice je namenjena za pripremu grafike za Web; njom delite sliku na viãe oblasti, od 
kojih svaka moæe postati hiperveza ka drugoj Web lokaciji. O upotrebi ove alatke 
viãe ñete saznati u lekciji 24.

 

Alatke za slikaçe

 

U grupi alatki za slikaçe nalaze se åetkica (Brush), olovka (Pencil) i peåat za kloni-
ranje (Clone Stamp). Sve one nanose “boju” na platno, baã kao i çihovi klasiåni 
pandani. Olovci i åetkici moæete da promenite debàinu i ugao. U kutiji sa alatkama, 
ove dve alatke dele mesto sa alatkom za zamenu boje (Color Replacement). Na traci 
sa opcijama alatki postoji dugme kojim se åetkica pretvara u rasprãivaå (vazduãnu 
åetkicu), i klizaå kojim se podeãava intenzitet mlaza  rasprãivaåa – baã kao u stvar-
nom svetu. Pomoñu peåata za kloniranje kopirate deo povrãine slike koji odgovara 
obliku aktivne åetkice i prenosite ga tamo gde pritisnete miãem. Postoje i razliåite 
gumice koje, kao ãto pretpostavàate, briãu delove slike. Moæete koristiti blok gumicu 
ili brisati bilo kojom åetkicom. Tu su i dve gumice za specijalnu namenu: gumica za 
brisaçe pozadine (Background Eraser) i åarobna gumica (Magic Eraser). Upotrebite 
ih da biste automatski obrisali pozadinu, odnosno izabranu boju.

Deo slikarskog kompleta su i åetiri specijalne alatke za retuãiranje: Healing Brush 
(koja izgleda kao hanzaplast), Spot Healing Brush (hanzaplast postavljen preko 
kruæne selekcije), Patch (koja izgleda kao zakrpa za farmerke) i Red Eye (jednona-
menska alatka uvedena u Photoshop CS).

Alatke Spot Healing Brush i Healing Brush boàe od peåata retuãiraju sitne detaàe 
na slici zato ãto deluju samo na fleke, nabore ili ogrebotine koje æelite da uklonite, 
a ne utiåu na okolne povrãine.

Alatka Patch “krpi” veñe povrãine i beãavno ih uklapa u pozadinu. Alatka Red 
Eye je neophodna za korigovanje boje oåiju (crvene boje na fotografijama ljudi i 
zelene boje na fotografijama æivotinja).

 
SLIKA 1.5
Alatke za izbor 

Marquee i Lasso.
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Istorijska åetkica (History Brush) veoma je korisna alatka pomoñu koje moæete 
– zajedno s paletom History – selektivno poniãtavati i ponavàati proizvoàan broj 
operacija i poteza åetkicom. Åetkica istorije umetnosti (Art History Brush) omogu-
ñava da pri slikaçu simulirate razliåite umetniåke stilove.

Alatka za prelive (Gradient) omoguñava da napravite pozadine åija se boja 
meça od jedne u drugu, pa åak i kroz åitav spektar. Kanta s bojom (Paint Bucket), 
koja deli mesto sa alatkom za prelive, “izliva” boju predçeg plana na izabranu 
povrãinu slike.

Na kraju, postoje i alatke koje pomeraju, zamagàuju i meçaju intenzitet slike. To 
su alatke Blur/Sharpen/Smudge i Dodge/Burn/Sponge. Druga i treña alatka iz sva-
kog skupa nalaze se na potpaletama. Ove alatke su detaàno opisane u lekciji 6, “Sli-
kanje åetkicama”, u lekciji 7, “Digitalno slikaçe” i u lekciji 8, “Pomeraçe boja”.

 

Alatke za putaçe, tekst i oblike

 

Ove alatke nije tako lako klasifikovati kao alatke za slikaçe i alatke za izbor. Slovo 

 

T

 

 
predstavàa alatku za tekst (Type) kojom se tekst dodaje na sliku. Alatke Pen, predsta-
vàene sliåicom pera, crtaju putaçe – ãto je jedan od naåina za crtaçe linija ili oblika. 
Kada nacrtate liniju ili oblik, alatkama Pen moæete izabrati deo putaçe i preobliko-
vati ga. Alatke Pen mogu se koristiti i kao alatke za izbor i kao alatke za slikaçe. 
U lekciji 13, “Putaçe”, nauåiñete da radite sa svim alatkama za putanje.

Pomoñu alatki za oblike (Shape) moæete da crtate i popuçene i nepopuçene 
oblike, ukàuåujuñi pravougaonike, elipse, poligone (mnogouglove) i proizvoàne 
oblike. Alatka za crtaçe linija (Line) takoœe je deo ovog skupa alatki. Njom crtate 
prave linije koje su, kada dræite pritisnut taster Shift, pod uglom od 45 ili 90 stepeni 
– kao da za crtaçe koristite klasiåan T-leçir i trougao. Na slici 1.6 prikazane su 
alatke Shape i neki od proizvoànih oblika.

 
SLIKA 1.6
Moæete da napravite i 

nove, sopstvene oblike.
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Alatka za napomene (Notes) funkcioniãe analogno æutim, samolepivim listiñima 
za poruke. Koristite ih da biste, tokom rada, u dokumente dodali napomene. Napo-
mena moæe da se smesti ili na platno, ili na susedne povrãine (ali svakako u prozoru 
dokumenta). Moæete koristiti åak i glasovne poruke, pod uslovom da je na vaã raåu-
nar prikàuåen mikrofon. Napomene se ne vide na odãtampanoj slici.

 

Alatke za prikaz

 

Postoje dve prave alatke za podeãavaçe prikaza: ãaka (Hand) i alatka za zumiraçe 
(Zoom). Alatka za zumiraçe je oznaåena sliåicom lupe, a alatka Hand – sliåicom 
otvorene ãake. Alatka Zoom omoguñava da uveliåate prikaz slike tako ãto ñete alat-
kom pritisnuti negde na platnu, ili da ga umaçite tako ãto ñete pritisnuti alatkom 
dræeñi taster Alt (Windows), odnosno Option (Macintosh). Pritisnite i povucite alat-
kom za zumiraçe da biste obuhvatili odreœeni deo slike. Kada uveliåate prikaz slike, 
slika je obiåno prevelika da biste je videli celu. Alatka ãaka pomera sliku unutar 
prozora i veoma je korisna nakon uveliåavaça slike alatkom Zoom. Upotrebite 
alatku Hand da biste na zgodno mesto pomerili deo slike koji æelite da vidite ili obra-
dite (slika 1.7). Pritisnite razmaknicu da biste privremeno pristupili alatki Hand dok 
koristite neku drugu alatku.

U ovu kategoriju moæemo ukàuåiti i pipetu (Eyedropper), biraå boja (Color Sam-
pler), leçir (Ruler) i brojaå (Count). Pipetom uzimate uzorak boje koju pritisnete – ta 
boja postaje aktivna pa çome moæete da slikate. Mesto na ekranu koje pritisnete 
alatkom Color Sampler oznaåava se kao referentna taåka, a svi podaci o boji te taåke 
smeãtaju se na paletu Info. U jednom trenutku moæete åuvati informacije o najviãe 

 

SLIKA 1.7
Alatka ãaka pomera sliku 

unutar prozora. Moæete je 

koristiti ili u glavnom 

prozoru dokumenta ili, 

kao na ovoj slici, 

u prozoru za navigaciju 

(Navigator).
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åetiri uzorka. Alatka Ruler se koristi za mereçe rastojanja i uglova na slici. Pritisnite 
i povucite liniju da biste izmerili rastojaçe izmeœu dve taåke. Rastojaçe ñe biti pri-
kazano u prozoru Info. Da biste izmerili ugao, prvo nacrtajte liniju od koje ñete da 
merite. Zatim postavite kursor na jedan kraj linije. Dræeñi pritisnut taster Alt (Win-
dows), odnosno Option (Mac), povucite od krajçe taåke linije u pravcu ugla.

 

Preåice za alatke

 

Svaku alatku moæete izabrati tako ãto ñete je pritisnuti miãem u kutiji sa alatkama, 
ali Photoshop nudi joã lakãi naåin za pristup alatkama. Umesto da pritisnete alatku 
koju æelite da koristite, otkucajte odgovarajuñe slovo. Da biste se prebacivali s jedne 
na drugu alatku na potpaleti, dræite Shift i pritiskajte slovo preåice sve dok ne doœete 
do alatke koja vam treba. U tabeli 1.1 dat je spisak alatki i çihovih preåica. Obele-
æite ovu stranu da biste lako pronalazili tabelu dok ne zapamtite sve preåice za akti-
viraçe alatki.

 

Traka sa opcijama alatki

 

U ranim verzijama Photoshopa, opcije alatki su bile smeãtene na paletu sliånu 
paletama Layers ili History. U verziji 6 nauåili smo da koristimo traku sa opcijama 
alatki. Kad meçate alatke, izgled trake se meça da bi se prikazale opcije raspolo-
æive za datu alatku. Ako traka nije prikazana na ekranu, izaberite stavku Options 
iz menija Window, ili dvaput pritisnite bilo koju alatku.

 

TABELA 1.1

 

Alatke i çihove preåice

 

Alatka Preåica Alatka Preåica

 

Move V Dodge/Burn/Sponge O

Marquee M Pen P

Lasso L Type T

Quick Selection W Path Selection A

Crop C Shape U

Slice K Notes N

Spot Healing Brush J Eyedropper I

Brush B Hand H

Clone Stamp S Zoom Z

History Brush Y Prebacivaçe boja 

Background/Foreground

X

Erasers E Podrazumevane boje D

Gradient G Re

 

æ

 

im Quick Mask Q

Blur/Sharpen/Smudge R Re

 

æ

 

im Screen F       
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Na traci postoji i opcija Tool Preset (unapred podeãene alatke, tj. skupovi unapred 
podeãenih parametara alatke). Nalazi se na levom kraju trake i prikazana je na slici 
1.8 (kada je aktivna alatka Brush). Koristite je da biste saåuvali odreœene skupove 
parametara za alatke koje åesto upotrebàavate – na primer, veliku åetkicu mekih 
ivica za slikaçe oblaka ili malu, tvrdu gumicu za doterivanje detaàa. 

 

Sadræaj menija

 

Meniji duæ vrha ekrana sadræe komande koje omoguñavaju da otvarate datoteke i 
radite s çima. Pritisnite meni da biste ga otvorili a zatim izaberite komandu. Ako 
izaberete stavku menija pored koje se nalazi strelica, otvoriñe se podmeni; ukoliko su 
pored stavke menija tri taåke, otvoriñe se okvir za dijalog.

 

Meniji File i Edit

 

Prva dva menija su File i Edit. Photoshopovi meniji File i Edit biñe poznati svima koji 
su koristili neke druge programe za Windows ili Macintosh. Meni File omoguñava da 
radite s datotekama: da ih otvarate, zatvarate, snimate, uvozite, izvozite,  ãtampate, i 
da izaœete iz programa. Tu je i nekoliko opcija za automatizaciju koje ñe vam pomoñi 
da uãtedite vreme, a o kojima ñete uåiti u lekciji 19, “Specijalni efekti i korisni trikovi”.

Pretraæivaå datoteka (File Browser), uveden u Photoshopu 7, preimenovan je 
u verziji CS2 u Bridge (most), a u novoj verziji – Bridge 2.0 – znaåajno je poboljãan. Da 
biste ga isprobali, izaberite File>Browse. Dok gledate fotografiju ili skeniranu sliku, 
videñete sve podatke o çoj, a moæete dodavati i sopstvene kljuåne reåi da bi pretraæi-
vaå lakãe pronaãao i otvorio datoteke. Poãto otvorite Bridge, moæete da pretraæite 
izabrane direktorijume sa slikama, a zatim da sadræaj direktorijuma sortirate i filtri-
rate po tipu datoteke, kljuånim reåima, datumu ili nekom drugom kriterijumu. Kad 
pronaœete direktorijum koji vam treba, sve slike koje se nalaze u çemu biñe prikazane 
kao slajdovi (slika 1.9). Da biste otvorili sliku, pritisnite je dvaput. Videñete i sve raspo-
loæive informacije o slici, ukàuåujuñi çenu veliåinu, model boja, datum i vreme kada 
je snimàena, proizvoœaåa i model koriãñenog fotoaparata, i druge podatke.

U meniju Edit nalaze se sve komande za obradu dokumenata koje poznajete iz 
drugih aplikacija: Cut, Copy, Paste, Clear i – najvaænija od svih – komanda Undo. 
Tu su i komande za transformisaçe pomoñu kojih moæete da poveñavate, smaçu-
jete, iskoãavate, deformiãete i rotirate selekcije.

 
SLIKA 1.8
Svaka komponenta trake 

sa opcijama alatki koja 

ima dugme sa strelicom, 

ima i potpaletu ili pada-

juñu listu s dodatnim 

opcijama.
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Meniji koji vam moæda neñe biti poznati (ako niste proveli dosta vremena radeñi 
u drugim grafiåkim programima) jesu:

 

é

 

Image

 

é

 

Layer 

 

é

 

Select

 

é

 

Filter

 

é

 

View

 

é

 

Window

 

Meni Image

 

Meni Image, prikazan na slici 1.10, ima nekoliko podmenija. Prvi od çih, Mode, 
omoguñava da izaberete reæim boja u kojem ñete raditi. U veñini sluåajeva radiñete 
u reæimu RGB zato ãto na taj naåin monitor prikazuje boje. Reæimi boja se detaàno 
opisuju u lekciji 4. Drugi podmeni, Adjustments, verovatno ñete koristiti za svaku 
sliku na kojoj budete radili. U çemu se nalaze sve vrste podeãavaça boja, od auto-
matskih korekcija nivoa i boje, do klizaåa za podeãavaçe kontrasta, pretvaraçe 
crvenih ruæa u plave itd. Alatke iz podmenija Adjustments opisane su u lekciji 5.

 
SLIKA 1.9
Bridge omoguñava 

da vidite umaçene 

prikaze svih dokumenata 

u izabranom 

direktorijumu.

 

Napomena za korisnike Macintosha
Od Photoshopa CS, komanda Preferences premeãtena je u krajnji levi Pho-

toshopov meni u okruæenju Mac OS X; pod Windowsom, ona se i dalje nalazi

u meniju Edit. 

 Uzgred budi
        reåeno
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U meni Image smeãtene su i alatke koje ste veñ videli – za poveñavaçe slike i 
platna na kome se ona nalazi – kao i dodatne alatke za invertovaçe boja, posteriza-
ciju, pa åak i za korigovaçe boja i zasiñeça na osnovu primera.

 

Meni Layer

 

Moglo bi se tvrditi da je najmoñnija osobina Photoshopa moguñnost rada na razliåi-
tim slojevima. To vam omoguñava da kombinujete slike, pravite kolaæe i korigujete 
boje ne strahujuñi da ñete pokvariti originalnu sliku. Razmiãàajte o tome kao o radu 
s viãe providnih folija. Svaki sloj je potpuno odvojen od drugih. Na jednom sloju 
moæete slikati, meçati mu providnost, ili raditi bilo ãta drugo a da pri tom ne naru-
ãite pozadinu niti delove slike koji se nalaze na drugim slojevima.

Meni Layer otvara okvire za dijalog za izradu novih slojeva. Sadræi i mnoge 
komande za kombinovaçe slojeva, rad s çima, primeçivaçe stilova i efekata 
slojeva, i podeãavaçe boja. Slika 1.11 prikazuje sadræaj menija Layer. U lekcijama 
5 i 11 nauåiñete kako da radite sa svim vrstama slojeva. 

 

Meni Select

 

Imate alatke za izbor – zaãto vam onda treba i meni Select? Komande iz menija Select 
– zajedno sa alatkama za izbor – omoguñavaju da modifikujete izabrane oblasti. 
Moæete poveñati ili smaçiti selekciju za proizvoàan broj piksela, ili joj umekãati ivice 
tako da izgleda kao da se stapa s pozadinom na koju ste je postavili. U lekciji 3, “Pra-
vàeçe selekcija”, nauåiñete sve trikove za biraçe delova slike i rad sa selekcijama.

 
SLIKA 1.10
Podmeni 

Adjustments.
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Meni Filter
Filtri åine da rad u Photoshopu bude zabavniji. Meni Filter sadræi petnaestak kate-
gorija filtara: neki zamagàuju ili izoãtravaju sliku, drugi je deformiãu, a treñi je pre-
tvaraju u imitacije poznatih slikarskih pravaca, crteæe drvenim bojicama ili skulpture 
od neonskih cevi. Toliko toga moæete raditi s filtrima, da su im posveñene åak åetiri 
lekcije: lekcija 14 “Poåetak rada s filtrima”, lekcija 15, “Filtri koji poboàãavaju sliku”, 
lekcija 16 “Filtri koji slici daju umetniåki izgled” i lekcija 17, “Filtri za izobliåavaçe 
i ostale zanimàive efekte”.

Meni View
Poput alatke Zoom, meni View ima komande pomoñu kojih moæete da uveliåavate 
i umaçujete prikaz slike. Kao ãto vidite na slici 1.12, u meniju View su i komande za 
upravàaçe leçirima, voœicama i mreæama koje omoguñavaju da precizno postavite 
objekte na radnoj povrãini. Komanda Show otvara podmeni za pristup mreæama, 
voœicama, napomenama, ivicama sloja ili selekcije itd.

 
SLIKA 1.11
Meni Layer.

 

Åinjenice o filtrima
Photoshopovi filtri su dodatni programski moduli i mnogi od çih rade i s dru-

gim grafiåkim programima. Ako instalirate filtre drugih proizvoœaåa, kao ãto su

Alien Skinov Eye Candy ili Andromeda, oni ñe se pojaviti na dnu menija Filter.

 Uzgred budi
        reåeno
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Leçire moæete podesiti da mere u pikselima, centimetrima, milimetrima, inåima, 
taåkama, pajkovima ili procentima. Izaberite merne jedinice koje najboàe pozna-
jete. Podeãavate ih u okviru za dijalog Preferences koji se otvara kada izaberete 
Edit>Preferences>Units & Rulers (Windows), odnosno Photoshop>Preferences>Units 
& Rulers (Mac OS X). Merne jedinice koje ovde izaberete vaæe i u okviru za dijalog 
New (pogledajte ponovo sliku 1.1). Kada pripremate dokumente za Web, najboàe je 
da podesite leçire na piksele.

Voœice su linije koje postavàate preko slike da biste precizno pozicionirali tekst ili 
neki drugi element koji dodajete slici.  

 
SLIKA 1.12
Meni View.

 

Isprobajte
    sami

Postavàaçe voœica

t

t

Da biste postavili voœice, pratite sledeñe korake:

1. Ako ne vidite leçire uz ivice aktivnog prozora, izaberite 
View>Rulers da biste ih prikazali.

2. Ukoliko hoñete da postavite horizontalnu voœicu, pritisnite 
miãem leçir pri vrhu prozora i vucite nadole. Videñete liniju 
kako klizi niz platno dok vuåete miãa. Na levom leçiru vidite 
poloæaj linije.

3. Ako hoñete da postavite vertikalnu voœicu, pritisnite miãem leçir 
s leve strane prozora i vucite nadesno. Videñete liniju kako klizi 
preko platna dok vuåete miãa. Na gorçem leçiru vidite poloæaj 
linije. Primer je prikazan na slici 1.13.

4. Da biste promenili orijentaciju voœice dok vuåete, dræite pritisnut 
taster Alt (Windows), odnosno Option (Mac).
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Kada postavite voœicu, moæete je pomerati samo alatkom Move. (Voœicu moæete 
postaviti bez obzira na to koja je alatka aktivna.) Kako biste sakrili voœice, izaberite 
View>Show>Guides da uklonite kvaåicu pored naziva opcije. Za uklaçaçe svih 
voœica izaberite View>Clear Guides. Voœice ñete fiksirati (zakàuåati) ako pritisnete 
Alt+Ctrl+; (Windows), odnosno Option-Cmd-; (Mac).

Komanda Show Grid, koja se takoœe nalazi u meniju View (View>Show>Grid), 
postavàa celu mreæu voœica preko slike, kao sloj providnog milimetarskog papira. 
Komande Snap To olakãavaju pozicioniraçe elemenata, na primer bloka teksta. 
U suãtini, one åine da mreæa bude “namagnetisana” tako da privlaåi sve objekte koji 
joj se pribliæe.

Meni Window
Veñini Photoshopovih komandi moæete pristupiti na viãe naåina. Najlakãe je koristiti 
palete. Photoshopove palete sadræe informacije o slici, parametre za kontrolu zna-
kova i pasusa pri koriãñeçu alatke za tekst, i opcije za mnoge alatke iz kutije sa alat-
kama. Osim toga, palete omoguñavaju izbor veliåina i oblika åetkica i boja, te pristup 
slojevima, putanjama i kanalima. Tu su i palete Actions i History, koje pomaæu da 
radite efikasnije, da vidite ãta ste uradili, i da se – ako treba – vratite na neku pret-
hodnu fazu rada. Meni Window (slika 1.14) prikazuje i sakriva ove palete. Ako su 
otvorene i palete koje ne æelite joã da koristite, na primer Actions, zatvorite ih da ne bi 
zauzimale prostor na ekranu.

 
SLIKA 1.13 t
Voœice omoguñavaju 

da postavite tekst

ili objekte baã tamo 

gde æelite.

▲
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U Photoshopu CS3, paletama je promenjen izgled – deluju glatko, a tako i funk-
cioniãu. Moæete ih sve smestiti na sklopive dokove uz ivice ekrana, tako da vam ne 
zaklanjaju pogled dok radite; kada vam zatrebaju, samo ih pritisnite miãem. Dokovi 
su prozirne sive oblasti koje se proãiruju po potrebi kako bi prihvatile onoliko paleta 
koliko ih tamo postavite.  

 
SLIKA 1.14
Da biste doveli paletu u 

predçi plan, izaberite je 

iz menija Window, ili priti-

snite çen jeziåak.

 

Isprobajte
    sami

Rad s dokovima za palete

▼ Da biste nauåili kako se koriste dokovi za palete, pratite sledeñe 
korake:

1. Pritisnite miãem vrh doka na desnoj strani ekrana; palete koje se 
na njemu nalaze sveãñe se na ikonice – sliåice kojima su pred-
stavljene funkcije paleta.

2. Pritisnite ikonicu palete da bi ta paleta iskoåila iz doka; pritisnite 
je ponovo – paleta ñe se vratiti na dok.

3. Povucite ikonicu van doka kako bi se paleta oslobodila; onda je 
moæete smestiti na proizvoljno mesto na ekranu.

▲

4. Kada hoñete da raãirite palete, ponovo pritisnite dok na istom 
mestu.

5. Ako pritisnete oblast doka iznad kutije sa alatkama (ili palete 
alatki), paleta se neñe saæimati i ãiriti nego ñe se prikazivati u 
obliku jedne visoke kolone ili u dve krañe kolone.
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Meni Help
Posledçi meni je Help; pomoñu çega pristupate Photoshopovoj obimnoj ugraœenoj 
bazi podataka za pomoñ tokom rada. Tu se nalazi skoro celo uputstvo za rad i dobra 
funkcija pretraæivaça.

Podeãavaçe parametara programa
Kako budete boàe upoznavali Photoshop, poæeleñete da promenite naåin na koji on 
obavàa odreœene poslove. Na primer, koristiñete sistemski biraå boja umesto Photo-
shopovog, ili ñete u jednom projektu koristiti centimetre, a u drugom piksele. Moæda 
ñete hteti da promenite boju voœica zato ãto je suviãe sliåna boji pozadine fotografije. 
Sve ove izmene, i mnoge druge, obavàaju se u okviru za dijalog Preferences, koji se 
otvara kada izaberete Edit>Preferences (na Macu OS X, Photoshop>Preferences). Kar-
tica General okvira za dijalog Preferences prikazana je na slici 1.15. 

Pritiskajte dugme Next da biste pregledali sve okvire za dijalog Preferences. 
Moæda ñete naiñi na parametre koje ne razumete. Zasad ostavite podrazumevane 
(ponuœene) parametre. Kada nauåite viãe o programu, moæete se vratiti i promeniti 
parametre po potrebi.

 

Zagubili ste paletu...
Ako “izgubite” paletu i ne znate kako da je ponovo prikaæete, uvek se moæete

vratiti na Photoshopovu poåetnu konfiguraciju paleta tako ãto ñete izabrati

Window>Workspace>Reset Palette Locations.

 Da li ste
 znali?

 
SLIKA 1.15
Podeãavaçe 

parametara.
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Saæetak
U ovoj lekciji ste poåeli da se snalazite u Photoshopovom prozoru i nauåili ste da 
napravite nov dokument (praznu stranu). Zavirili ste u kutiju sa alatkama i u Photo-
shopove menije, te nauåili kako se postavàaju i koriste voœice, mreæe i leçiri. Na 
kraju, saznali ste gde se podeãavaju parametri programa.

Radionica

Pitaça i odgovori
Pitaçe: Ãta su boja predçeg plana i boja pozadine?

Odgovor: Boja predçeg plana je gorçi od dva obojena kvadrata u kutiji sa alat-
kama. To je boja koju nanosi åetkica. Boja pozadine je doçi kvadrat. 
Tu boju vidite kada obriãete “boju” sa platna.

Pitaçe: Åemu sluæi sliåica na vrhu palete sa alatkama?

Odgovor: Ako ste povezani s Internetom i pritisnete tu sliåicu, otiñi ñete na Web 
lokaciju kompanije Adobe, gde ñete nañi ideje, savete, najnovije vesti 
o Photoshopu i – naravno – informacije o programu.

Pitaçe: Zaãto postoje korpe za otpatke na dnu nekih paleta, npr. History i Layers?

Odgovor: Ako pritisnete sliåicu korpe za otpatke na paleti Layers, briãe se izabrani 
sloj. Sliåno tome, kada pritisnete sliåicu korpe za otpatke na paleti His-
tory, briãe se izabrano istorijsko staçe. Viãe o tome nauåiñete kada 
budemo govorili o poniãtavaçu operacija u lekciji 2, i o slojevima, 
u lekciji 11.

Pitaçe: Kako da nacrtam okvir oko reåi koje sam postavio na sliku?

Odgovor: To je jedna od lepih stvari koje mogu da obave alatke za oblike (Shape). 
U lekciji 13 nauåiñete kako da ih koristite. Na paleti proizvoànih oblika 
postoje åak i oblaåiñi za tekst.

Kviz
1. Kako moæete da uveliåate prikaz da biste pogledali sliku iz veñe blizine?

A. Postavite alatku za zumiranje na deo slike koji æelite da vidite i pritisnite 
taster miãa.

B. Dræite Alt/Option i pritisnite alatku za zumiraçe.

C. Dræite Shift i otkucajte zoom.

D. Dræite Shift i pritisnite taster + (plus).

2. Kako da umaçite prikaz da biste videli celu stranu?

A. Pritisnite Shift i taster - (minus).

B. Otkucajte zoom out.

C. Dræite Alt/Option i alatkom Zoom pritisnite bilo gde na slici.
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Reãeça kviza
1. A. Pritisnite ponovo da biste joã uveñali prikaz.

2. C. Videñete da se simbol plus unutar ikonice alatke (lupe) promenio u minus.

Veæbe
1. Otvorite nov dokument i isprobajte neke od pomenutih alatki. Pritisnite 

alatku Brush i nacrtajte neke oblike i linije. Pritisnite alatku Eraser i obriãite 
delove nacrtanih objekata. Povlaåite alatkom Smudge preko jedne od linija. 
Izaberite deo linije jednom od alatki za izbor, preœite na alatku Move i pome-
rite liniju na drugo mesto na ekranu. Istraæujte. Neñete niãta polomiti.

2. Ako ste povezani s Internetom, pritisnite dugme sa sliåicom na vrhu kutije sa 
alatkama. Posetite Adobeovu lokaciju na Webu i pogledajte åega tamo ima.


